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Event Scheduler
[bookmark: _Toc463439013]// Introduction and Background
This manual explains both the live front-end website as well as the Administration console for this booking and event management system, a feature-rich extension that is built on top of opencart..
[bookmark: _Toc463439014]Definition:
The Event Scheduler System is based on OpenCart ecommerce shopping platform software which an open source platform that falls under the general public license. Event Scheduler is a modular platform that is customised for selling tickets and managing bookings for events. A complete system with integrated communication with all the parts of the ticketing and booking processes and procedures.
This platform enables the store owner to market and sell both products and event events. Ticket redemption is also forming part of this feature rich platform. In the same fashion an online customer is continually updated on the status of an ordered product in an online store, events is also managed with HTML formatted emails with downloadable calendar functionality.
// Background
The Event Scheduler extension is one of the most advanced event scheduler extensions available for Opencart. It leverages all that makes Opencart such a fantastic platform to deliver a truly ground-breaking and feature-complete extension. The design philosophy which underpins the scheduler is to leverage as much of the core Opencart platform to ensure that all the features that the platform offers are available and usable in the context of the event scheduling/ticketing use-case. 

The plugin has been built using VQMOD. Currently only English is supported as a language, if you are able to assist with translations please let me know so that I can provide you with the requisite VQMOD files to perform the translation.
At its heart the extension treats a product as an event, and a manufacturer as an instructor. Some of the important features:
· Products are events
· Manufacturers are instructors
· Events have options which define what data is required for a booking, e.g. Timeslots, Attendee First Name, Attendee Last Name etc.
· Bulk management of event roster is supported (through upload/download of excel-based templates)
· Ticket redemption is supported through QR-Codes.
This plugin has been successfully used in a number of different use cases:
· To run a health care conference, with attendee bookings 
· To manage internal company training courses
· To manage demo and open days in the retail power tool space. 

Below is a high-level overview of the entities that have been introduced as well as how the Opencart framework has been customised to achieve the outlined capabilities. 
Instructors

An instructor is an extension of the Manufacturer entity. Like a manfacturer, an Instructor may be associated with one or more events. Unlike a manufacturer, an instructor is also associated with a customer. This association has been designed as such because an instructor is typically a person who has an address. Additionally, the following is relevant to instructors too:
· Skills - The skills the instructor has, relate to their abilities.
· Bio - An HTML-based bio of the instructor. 
· Availability Roster - Indicates when instructors are available. The roster is filled up as instructors are booked for events, or manually by administrators, for example when an instructor is on vacation. 
The result is that is now possible to, for example, use the standard Opencart manufacturer/brand modules to search for events that are associated to a specific instructor.
Events
The plugin takes the notion of products and extends them to be events, with manufacturers being extended to be Instructors. An event may or may not be associated with an instructor. In addition to the usual product settings, this plugin introduces the following event-specific settings:
· Start Date/Time and End Date/Time 
· Event Organiser - an association to an opencart customer who is deemed to be the organiser. The organiser's details are displayed on when viewing the product
· Location - Detailed location information, fully integrated with Google Maps search, which prepopulates the address form details. 
· Event Type - The type of event being configured.
· Timeslots - Flexible system allowing dates and timeslots with each of the dates to be configured. As with all other options, it is possible to configure stock subtraction, quantity available, price and points adjustments per timeslot. 
· Options - The data that must be captured for a given event. Any event option has a number of mandatory options, and then any number of optional options. The mandatory options include firstname, lastname, email address and attendance status (hidden). 
Options
Product options are used to represent the data that must be captured for bookings, which provides for an extremely extensible framework that allows users of this plugin to configure whatever options are applicable to their specific use-cases. This means that one may configure a conference with a "meal_choice" option because you need to know what to cater for, versus a demo day which would need a "customer_type" option so you can determine which 
Because product options are used to represent the attributes of the event, such as timeslots, attendee first name/last name etc, it is possible to provide extremely fine-grained control over quantities, if there is a limit on seat capacity, or if prices must be adjusted depending on options selected (for example Toast, versus Filet Mignon). Additional extensions introduced by this plugin for options includes:
· Placeholder Hints - standard HTML5 placeholder hints
· Visible - used to carry internal options which must be associated with a product but should not be visible - for example attendance status
· Validation-based Options - Allows for options to be configured which will perform some checks and only allow the booking to continue if the checks return true (See [url]http://www.opencart.com/index.php?route=extension/extension/info&extension_id=26485[/url] for more information) 

Roster
Each event has an associated roster. The plugin allows you to perform bulk import and export operations using Excel templates. Additionally, as is usual with any admin-side item listing, all the required filters are available to allow you to locate/manage your attendees. Finally it is possible to:
· view and manage attendance status for attendees (ATTENDING, ATTENDED, DID_NOT_ATTEND etc). 
· issue email comms relevant to the attendee status. 
· edit the roster, and update any attendee's detail. 
The population of the roster is based on the standard opencart ordering process, (see next section), hence it is not possible to remove an attendee. The export functionality is especially useful in the scenario where an event organiser wants to, for example, print out name tags/labels. The result is an excel spreadsheet containing all the attendee information. 
Order Processing

Every booking made translates into an order that is placed in the system, which means that attendees booked as part of an order, are only added to the event's roster once the order reaches a "Processing" state, i.e. when stock deduction triggers. If an order was in "Processing" state and then moves out of this state, for example the order is cancelled, then the attendee is removed from the roster. 

The plugin distinguishes between the person paying for the booking, and the attendees who the booking is being made on behalf of. These may be the same person (when a person is booking a seat for themselves, but often they may be different people).

The plugin also introduces the notion of anonymous bookings, which is relevant if for example a seat is free. In this context, the plugin will automatically create a booking as soon as the customer has completed their form and clicks the "Add To Cart" Button. In this way the booking process is extremely painless and straightforward. (Note: Anonymous bookings may be enabled or disabled, depending on the use case requirements). Note 2: Enabling Anonymous Checkout requires the Free Checkout payment module to be enabled. 
Email Communications 
The system implements rich html-based email templates to support all aspects of the booking process. The email templates follow the standard mail merge approach, with keywords in the HTML templates being replaced to make the resulting emails relevant to the party/attendee being emailed. The email comms that may be configured are: 
· Booking Confirmation Email - when an order is placed and is moves into the "Processing" state, the associated attendees are added to the event roster. At this point the booking confirmation email process triggers and the booking confirmation email is sent. 
· Booking Reminder Email - sent a day (as configured) BEFORE the event takes place to remind the attendee that their presence is required at the event
· Attended Email - sent POST event, assuming the attendee participated in the event.
· Did Not Attend Email - sent POST event, if the attendee did not attend the event. 

The administrator may decide which of the above templates are relevant for a given event, and is then able to disable/enable the relevant plugins.
Ticket Redemption
QR Codes are used to manage ticket redemptions. The comms templates mentioned in the previous section provide a [ticket_qrcode] function which means that the resulting email contains an inlined QR code specific to the seat for the event. The intention here is that when the attendee arrives at the event, the organisers can then scan the QR code which will then automatically update the attendance register to ATTENDED. The system also allows the administrators to control the redemption process, i.e. if the redemption process requires a logged in session, which customer groups are permitted to perform the redemption etc etc. The net result is that the plugin therefore allows the roster to be automatically updated.
Upcoming events module
The upcoming events module provides a rich set of customisations. It is possible to configure whether the module must render a summary of events (for example left column/right column) or full multi-language detail (center). It is also possible to specify a date range for the filters (for example to list "Events in 2017") or all upcoming events. 
Client-side requested events

One of the more specialised use cases, but this allows customers in specific customer groups to request an event to be created - an example of this use case is when a student would like their lecturer to give a lecture on a specific topic. In this case the student will request an event, specify the skills/topics of discussion, the location as well as the desired dates when the event should take place. 
Other features
· Google Maps Address Integration - can be enabled/disabled. If enabled allows for addresses to be search, with the resulting match used to pre-populate address forms for Event Locations, etc.
· Event Types - Open-ended configuration. As different event types are required, these may be added as required. 
Future Roadmap
· Add more translations
· Add support for label generation and attendance certificates
· Add support for feedback (specifically for training course use-cases). 
· Expand support to later versions of Opencart. 
· Wait lists. 

Installing the plugin. 
Unzip the zip file to the root of your website.
· Make sure you have VQMOD installed
· Navigate to Admin -> Default Store -> Settings. If installed properly you will see an "Event Scheduler" tab. Select the tab, and click the "Install Event Scheduler" button.
· Once installed, configure the various aspects of the event scheduler. 

[bookmark: _Toc463439015]

// The Front-end
[image: ]
Landing on the home page, one is welcomed with a mobile friendly website that has all the familiar components of an online shop. Enough space is provided for advertising and showing upcoming events or products that are on sale.

[bookmark: _Toc463439016]A click through
The following screens will show some of the features from a visitor’s point of view. What one can expects the visitor will experience when visiting the website.
[bookmark: _Toc463439017]Category
Al category is a link from the main menu. Therefor we refer to it as the category menu in the same way products in an online shop is categorised, we categorise events.
[image: ]Click on a category link in the top menu will display a category description, all the events and products related to this category as well as a navigation menu and advertising as per your design.







[bookmark: _Toc463439018]Viewing the event
[image: ]Clicking on the event in the category view, opens up the event detailed information page.
Information is now displayed in a TAB-type navigation. 
[bookmark: _Toc463439019]The description TAB
The description TAB display the story and information about the event.


[bookmark: _Toc463439020][image: ]The Event/Class TAB
The Event/Class TAB displays all the information related to the organiser, Contact details, Dates and time. Event reminders can be downloaded in three different formats to suit your calendar on your device or computer. Location detail including GPS Coordinates are shown. The number of available seat for this event is shown.
[bookmark: _Toc463439021][image: ]Instructor TAB
Information about the facilitator or instructor is shown here telling the visitor who he will be listening to.
Contact details related to the facilitator is shown should the visitor wish to talk or contact this person.





[bookmark: _Toc463439022]Booking for the event
[image: ]Booking for the event is as simple as filling in a form, selecting the date and answer some questions. If the vent is a free of charge event, then the Make Booking button will skip the shopping cart. Should this event involve payment, the booking will add to your shopping cart. You will then be able to add more events to the shopping cart and when you completed the shopping process, follow the checkout process which is familiar to other online shops.
Booking Example (as shown)
At a glance one can see who is the instructor/facilitator and the availability of this event. In this case it is fully booked and the system will not allow you to fill in the form and submit a booking.
Attendee information
This information relates to the actual person attending this course/event. All required information is clearly marked with a red asterisk. All these options are configurable through the backend administration platform. 
Should one fail to complete one of the required field, the system will not allow you to continue and show which fields are not completed.
Some of the information fields shown here can be switched On or Off through the configuration and setup of the event, discussed later in the Back-end Administration section of this manual.
If the user is logged in, some of the fields will be prepopulated.

[bookmark: _Toc463439023]The booking process
Once the form is completed and you click on the Make booking button, a confirmation will be displayed at the top of the screen and the system will send out an email to the user supplied email address.


[bookmark: _Toc463439024][image: ]The Confirmation email
An HTML formatted email confirming the booking is shown in the example (left):
This email format and wording is configured by the Events Coordinator in the back-end administration section for each event.
Attached to the detailed email, is a Calendar reminder attachment. You can add this reminder to your Calendar 










[bookmark: _Toc463439025]Logon screen
[image: ]
This screen allow you to either register for a new account on this platform or login if you are already a customer and registered before. Should you wish to login and forgotten your password, a Forgotten Password link is provided below the Password field.
To register for a new account, please refer to the next section in this chapter. I registration screen is discussed in detail.








[bookmark: _Toc463439026]Customer account
[bookmark: Accountregister][image: ]
The benefits of registering and account on the system holds various benefits. To name a few, you may return and use the system as a return customer without the need of going through the process again.
Again all required fields are marked with a red asterisk (*). Failure to complete required field will allow you to continue the registration process.
Address details are important as you as the store owner would like to be sure that your customers are in the correct demographical area, country or state.
A password is required. The system will allow visitors who forgot their password, to reset it via an email link.
Newsletter subscription is optional. This is important as spam is a frustration everybody has to deal with every day. Here you allow your customer to choose whether he/she wants to receive communication and marketing information from your company.
Agreement with the Privacy Policy. This option is configurable through the back-end administration system. This is to protect you in some respects.



[bookmark: _Toc463439027]The Dedicated Customer Group Account
Dedicated Customer Groups are employees with accounts in the system that allow them to use added features from the front-end of the website once logged in.
[image: ]
[image: ]Once logged in with an approved Dedicated Customer Group Account, the user will notice a View/Edit your events link under the My Events heading. Click this link and a screen with all the user’s events with status of each event will be displayed. 
[bookmark: _Toc463439028]My Events
Each event has a reference number that is used in all communication throughout the process. The status shown will implicate what is happening with your event booking. The approval process is handled by the internal decision maker in the relevant department.
To start a New Event, click the button on the screen…


[bookmark: _Toc463439029][image: ]Add New Event
Once the user clicked on the New Event button a popup screen is displayed with three easy to follow steps.
[bookmark: _Toc463439030]1. Settings
Required fields are market with a * red asterisk and the form will not allow the user to process to the next screen if the required fields are not completed.
Certain criteria is setup by an administrator in the back-end administration system for Event type, maximum and minimum duration of events as well as the skills sets as per demonstrators, trainers and facilitators.
To create a new event will require the user to select a Start Date and time as well as End date with the closing time. The event type is required and could be a dropdown list or a field where the user may type in what is expected.  Then select the skills required for your event and click on Find Instructors.
This system even allows an administrator to limit the amount of skills one can select for this even. When selecting Find Instructors, the system will go check if a facilitator, trainer or demonstrator meeting those skills are available on that particular date. It even checks vacations and other events. A trainer or demonstrator can never be double booked.

[bookmark: _Toc463439031][image: ]1. Settings | Find Instructor
Select a skill and click on Find Instructor. The system will search for all available instructors for the specified skill for that specific date and time. 
In the administration back-end system, the system administrator will setup all vacation days for all the demonstrators and instructors. Only if someone with that sill set is available, a name/s will show.
Should no instructors be listed, the user needs to either select a different set of dates or contact the events coordinator who administrates these types of events
The next step is to select an applicable instructor of choice and click on Next


[image: ]
[bookmark: _Toc463439032]2. Location
In this section of the popup, fill in the desired address where this event needs to take place.
Location Search: This box has Google Maps integration built into it and will auto populate while the user types in the address. The user will notice that once the address is found, the latitude and longitude field will be auto populated with the applicable coordinates of the address. Correction to these values can be made here.
Complete the rest of the fields to supply the events coordinators with accurate information.
Any additional detail that the user has at hand should be supplied in the applicable text box.
Note that complete and accurate information is crucial for event administration.
Click Next once all information is filled in.
[bookmark: _Toc463439033][image: ]3. Contact Info
This contact information is for the person who requires the event.
This information should be accurate
Please supply any additional detail in the text field to ensure that the events coordinator get a complete picture of what is required for this event.
Should the user desire to change any information in the previous screens, simply click on the Previous button and make the changes and again select Next.
When al information is correct, click on the Finish button
The My Events webpage will be updated with the new event submitted in the form of a table | added to all the other events requested by the user.

[image: ]






[bookmark: _Toc463439034][image: ]Communication
Important to note that a unique reference number is generated for each event booked. This reference number is communicated in all emails and communication between user and administrator.
The picture on the left shows an example of the email sent by the system to the person who requested the event/demonstration












[bookmark: _Toc463439035]// The Back-end
The EventScheduler is equipped with an administration website that controls the front-end website that user see on the Internet. This website will be referred to as the Admin Platform. In order to access the Admin Platform, simply type in the web address (domain name) and add /admin at the end EXAMPLE http://www.eventscheduler.co.za/admin in the address field of your browser.
The Admin Platform offers several layers of permissions and it is possible to change permission for specific user to be able to only change certain features, functions or simply only add more events.
[bookmark: _Toc463439036][image: ]Login details
When logging in on the Admin Platform, the user will we presented with the login details screen. 
This the user’s administration username and the matching password. A Forgotten Password link is also supplied if the login details was forgotten.


[bookmark: _Toc463439037][image: ] Admin Platform landing page
Once the user successfully added the username and password details the Admin Platform landing page will load in the browser also referred to as the Dashboard. 
A collapsible menu appears on the left hand side. This menu will then further expands to display each sub category related to the menu option.



[bookmark: _Toc463439038][image: ]Catalog Menu
Expanding the Catalog menu by clicking on the Catalog heading will display all the features related to Products and Events. 
Explanation of the linking process
Every Event or Product is linked in the system in several ways will several options as desired. The system is designed to also work on a multistore principal allowing a store with different departments as well as different stores running on the same platform. A Category, Product or Event can thus be linked to these different stores or departments.
The menu structure is built automatically by creating Categories and enabling them through a linking process to the store desired.
The linking process
1. The Category will thus be the first step to create
2. Whether you are adding a Product or Event, you will need to create a Manufacturer or Instructor.
3. Then a Product or Event will be created which will be linked to the Category 
[image: ]
[bookmark: _Toc463439039]Creating a Category

1. Click on the Categories menu item in the menu on the left
2. A list of existing categories (if any) will be displayed with edit buttons with each item displayed.
3. Then click on the “+” sign to add a New Category.






[bookmark: _Toc463439040]New Category
On the Add Category page, there are Three Tabs displayed; General | Data | Design
Description boxes have an editor enable where one can use the editor function or paste preformatted HTML code if stylesheet references are used specific to your design.
Note: all fields with a red * asterisk, are required fields and needs to be completed in order to save the screen data.
[image: ]On the General Tab
1. Give the Category a name. Note that this is the name that will be displayed in the menu, thus the shorter name you choose the better it will look on the live website.
2. The category will allow you to display a description/explanation about the Category on the website. Type a description if desired (Optional). Description boxes have an editor enable where one can use the editor function or paste preformatted HTML code if stylesheet references are used specific to your design.
3. Meta Tag Title: This is the title that is displayed by search engine results.
4. Meta Tag Description: This is the information that goes with the Title that is displayed by the search engine results. 
5. Meta Tag Keyword: These are keywords used by keywords to find your information relevant to the keywords used.
[image: ]On the DATA Tab
On this Tab the user will setup the flow of this category. Set whether this category is the top level or whether it has a parent that it falls under.
Parent
This box has an auto complete feature. Start typing the category under which top level category is linked to. If this is a top level category, then – none – will be one of the options that comes up in the auto complete list 
Filters
[image: ]If any filters were setup in the catalog features, these will be in the list which is also auto complete as the user types. Leave blank if this category is not linked to a filter.
[bookmark: _Toc463439041]Stores
If the system is a multistore setup, then tick the stores that this category will be linked to and it will thus display on every store that is ticked.
[bookmark: _Toc463439042]SEO Keyword
A globally unique keyword that will be picked up by the search engines that is applicable with this category specific. Do not use spaces. Use “-“ (minus sign) between words if keyword has to be more than one word.
[bookmark: _Toc463439043]Image
If you want to display an image with the category description once the category was clicked on the live website, this image [image: ]will be displayed. Leave open if no image is desired. The sizes of the image is relevant to image size settings as per the store settings in the System menu.
[bookmark: _Toc463439044]Columns
Normally set to [1]. Here the number of columns is set for the bottom three categories. This feature only works for the top parent categories.
[bookmark: _Toc463439045]Sort Order
Very important feature. Here one sets the order in which the category should be displayed. If all is set to zero [0], then it sorts alphabetically. Zero [0] is at the top, one [1] is second, two [2] is third and so forth.
[bookmark: _Toc463439046]Status
The category is switched ON or OFF by selecting an option from the dropdown box.


[image: ]
On the Design Tab
Layouts is the way a page is displayed and is setup under layouts in the Design -> Layouts menu.
It is possible to override the standard layout by selecting a specific layout from the dropdown box.
[image: ]
Once the user is satisfied with the information, then click on the Save            icon at the top of the categories window


[bookmark: _Toc463439047]The Catalog -> Products menu
The Event Scheduler platform can sell both events and products. Both can be linked to the same categories as well, making this platform really powerful. One can sell a training course plus sell accessories that can be used in the training course under the same category.
[image: ][image: ]
[image: ]
To add a new product to the website, click on the add icon at the top right

 
The next section will explain in detail how to add a new product to the website. This part will show how to use the built-in editor as well as how to add your own HTML to the product description.



[bookmark: _Toc463439048][image: ]Add Product 
The platform is capable to sell both event tickets as well as products and services. In order to setup a product to sell, the user need to prepare certain information. A picture/photo of the product which the platform will use as an icon for the product as well as a larger zoom picture when enlarged. Picture sizing is automatic and only a higher resolution picture need to be uploaded.
The description for the product including its specification and relevant info that the user wants the visitor to the website to read should be prepared. The platform allows for both HTML code to be added as we ll as a built-in editor to compile the information. 
[image: ][image: ]
[image: ]In order to add a new product, simply click on the Add New Product icon at the top right hand side. It is the blue icon with the + sign in it.
[image: ]The Add Product screen will open displaying text fields where information needs to be entered. Several Tabs are displayed in the top row for adding detail, linking, adding attributes and options, etc to this applicable product.
Note that all field marked with a red * are required field and the user will not be able to save the product data if all these required field are not completed. A warning box will be displayed when saving and one of these fields was not competed.
[image: ][image: ]
Starting with the General Tab the process is as follows. Refer to the picture above:
1. * Product Name. This text field is the first required field and a proper product name needs to be entered here. Example: Screwdriver, 3mm, Flat, Resin Handle
2. Description. This field includes a text editor that will allow the user to neatly format the information to be displayed as seen on screen (WYSIWYG).
a. [image: ]Selecting a style. Normal, a quote or headers of different sizes


b.[image: ] 	All the standard formatting tools as used in standard text editors.
[image: ]The symbol on the left is the code selection icon. The user may paste HTML code once selected or edit HTML once in this view.
3. * Meta Tag Title. Another required field. This is the title that search engines will display for your product. Use a decent title that is relevant to the product.
4. Meta Tag Description. An important tag for search engine results. This information will be displayed by the search engine when it finds you product. Neat and precise information makes your website stand out among others on the internet.
5. Meta Tag Keywords. Use proper keyword that can be used by search engines and separate them with commas.
6. Tags. In order to make your website user-friendly, product tags can be used to find products that are related. Any product with the same tag will be listed if this tag you entered here is clicked.
Moving on to the Data tab at the top. This tab requires everything related to the product itself.[image: ] The product image that will be used as an icon and a zoom image and the model. The model is a required field and is normally you catalogue number for the specific product. The rest of the fields is applicable as desired
[image: ]The links tab makes the product visible in the right place by linking it to the correct category and manufacturer (brand). As the tab describes, it is all related to how everything is linked together. Related products are products that is similar, or a spare part for this product. It can be accessories or simply a suggestion that will complete this product.
[image: ]The image tab allow the user to add more additional images that will also be displayed as icons that can be enlarged (zoomed). Very useful to display other views and accessories for the applicable product. More images makes this product stand out.
[bookmark: _Toc463439049]Other tabs. 
The other tabs at the top of the screen is to specify attributes and apply predefined options. Discount and special offers can be applied as well as overriding a design to display the product layout differently from other products.
[bookmark: _Toc463439050]The Catalog -> EVENTS menu
[image: ]Adding events is what this platform is all about. An even can be defined as a course, a show, demo or any type ticketing function. An event can be a function that you sell or it could be free of charge with no registration for the customer. 
Powerful features like communicating with the customer via email or SMS is part of the setup. Further customization is possible.
[image: ]Adding an event is accessed through the catalogue menu by selecting Catalog  Events.
[image: ]
When accessing the events menu item from the menu, the Events Home administration page is opened. Explaining the screen shown above, the following features are possible:
[image: ]Add event. This button is selected when creating a new event from scratch. To use this method takes some preparation beforehand and get all the applicable information ready
[image: ]Download attendee roster. When selecting the tick box next to an event and clicking this button with download the roster for that applicable event in Microsoft Excel *.xlsx format.
[image: ]The copy feature. Select an existing event, click this button and a copy of the applicable event will be created for editing. A shortcut in speeding up the process of creating similar events.

[image: ]Plain and simple – Trash it. There is no return beyond this point. Once you hit this button and confirmed, you cannot undo your action – it is gone forever!
[image: ]This button will open up the roster of the applicable event. The roster with show the status of the event, whether certain emails are sent out, the order number, the date/time that was selected, the first name of the customer and all applicable details.
[image: ]Edit the event. Clicking this button, will open up the event and allow one to make applicable changes to the event.

[bookmark: _Toc463439051][image: ]Create a new event 
Before creating a new event, there are certain information that one needs to prepare upfront. First of all it needs to be considered whether the Bootstrap styles need to apply and the look should show in a certain fashion. This comes down to choosing between using the built-in editor or preparing the HTML separately in an external editor and pasting it in the description field.
Care should be taken to ensure that all require fields (marked with a red *) are completed with the required information.
Note: Ensure that the event is DISABLED whilst editing the event. One can only save an incomplete event in the DISABLED mode.
[bookmark: _Toc463439052]Pre prep for creating a new event:
Information that needs to be prepared before starting with the process of creating a new event is the following:
1. Event must have a name
2. A Meta Tag Title needs to be typed in
3. An image needs to be prepared for this event that will be utilised by the system as an icon for the event as well as a large zoom picture.
4. An Event Code needs to be entered
5. The Event needs to be linked to a category else it will not show on the website
6. Event Configuration need to be set up:
a. Start Date/Time
b. End date/Time
c. Event Organiser – This person need to be a customer in the system
d. Event Duration needs to be specified
e. Event Type needs to be selected. This can be defined in the store Settings Event Scheduler Tab
f. The event location needs to be completed. Google integration allows the accurate positioning of the event
g. Timeslots for the event needs to be defined
h. Options for the event needs to be defined. Options can be removed if not needed.
i. Event communication need to be setup. These are emails that the system sends out to the customer when they book for the applicable event. Examples: Booking Confirmation, Reminder email, Attended email, Did not attend email. Emails can be enabled or disabled as required.

[bookmark: _Toc463439053][image: ]       Add Event
[image: ]Let’s start by creating and event from scratch. With all the prepared information required as per the above section of the document, we can proceed by clicking the          icon at the top right of the screen. See picture below. [image: ]
[image: ]When clicking the  Plus (+) sign icon the following screen will open in the browser window:
[image: ]
Note that by default, the event will be in the disabled status. The platform is designed to allow the user to save an incomplete event is the disabled status mode. (The status can be found under the Data Tab).

[image: ]Note: The Event information will not save any information added if the event information is incomplete with the status set to ENABLED.

[image: ]Note: All fields that are marked with a red asterisk (*) is a required field and must be completed with applicable information.

[image: Image result for tip icon png][image: Image result for question icon png]Tip: All field and text box heading that displays the blue question mark icon              offers more information when the user hovers the mouse point over the icon.
[image: ]
[bookmark: _Toc463439054] On the General Tab start completing every field as required.

*Event Name
Any event, whether it is a course, a concert or a show, it needs a proper understandable name. This name will be displayed on the live portal once its status is enabled.
Description
[image: ]
The platform ships with a HTML editor allowing the user to either used this editor or apply his/her own HTML code. The first icon in the icon bar displayed above refers to styles that is used by Bootstrap. 
This description box is used if you want the event to be displayed with proper useful information to attract visitors to the event. The better the content is put together, the better the live sit is experienced by visitors. If the description box is left empty, the description space on the site will stay empty. Thus only the event name will show.

*Meta Tag Title
This is releated to what search engines will find when a internet user searches for information. For example: The user searches for power tool training. Google will return something like the following:
[image: ]The blue heading is the link and this is also the Meta Tag Title.

Meta Tag Description
As per the example above, the description that is shown by Google in the search results is what you entered in tis text box.
Meta Tag Keywords
Use keyword that is specifically referring to your event. In the above example applicable keywords would be: power tool training,tool operator training,portable power tools, tool equipment regulations,
Important to also note that all keywords are separated by a comma.

Tags
This field displays all relevant tags that are applicable to your event. Example: The website has categories, products and events. Any other product or event that has the same tag as the one you are entering here, will be displayed in a list like a search result when a visitor clicks on the tag. Several tags can be used and needs to be separated by a comma. We use tags to group products and events that are related to the same topic, use or application.
[image: ]
[bookmark: _Toc463439055] On the Data Tab
The data tab consists of all information that is related to the product backend detail. This information relates to the accounting side, event code, price, etc.
[image: ][image: ]Image
To upload an image, click on the cart icon and select the blue icon
This will open up the Image Manager application in a pop-up window as shown in the picture below. Click on the upload icon as shown.
[image: ][image: ]
The Image Manager is intuitive and easy to use. Upload the new image into the appropriate folder and select it by double-clicking it to add it to the event.
*Event Code
This is a required field and the code used is as per your accounting system and relevant to this event only.

SKU  UPC  EAN  JAN  ISBN  MPN
These codes are not required but use them if it is required for your type of event setup and accounting, stock-keeping rules.
Continue to fill in all the fields as required. If no price is filled in, it means the event is free of charge. The Out Of Stock Status is important as this is the wording display when the vent is fully booked/out of stock. 
The Date Available is important. This is the date that visitors can start booking for this applicable event
Status
Here the user sets the event ON or OFF by selecting Enabled or Disabled. 
[image: ]
[bookmark: _Toc463439056]  Links Tab
To be able to display the event under a certain category it needs to be linked.
Instructor
This field is an autocomplete field and is only relevant for training courses.
Categories
This is an autocomplete field and the event can be linked to several categories. Linking to a category means the event will show in the category menu on the live website id enabled.
Filters
Also an autocomplete field. If any filters are specified in the setup under Catalog Filters, it will be linkable here.
Stores
If this platform is part of a multistore setup, the event can be linked here to the different sub stores.
Downloads
The platform also allows the event to be linked to any applicable downloads that exists in the system. Autocomplete feature.
Related Products/Events
The user can link this applicable event to any other existing products and/or event. This also has the autocomplete feature.

[bookmark: _Toc463439057][image: ]Attribute tab

If any attributes are specified under Catalog Attributes, they can be applied here to the event.
[image: ]
[bookmark: _Toc463439058] Event Config Tab

This the most important tab to complete. The more detail provided the better the visitor to the website is informed. 
[image: ]Please note to ensure that event status is set to the disabled status to be able to save any information that is incomplete.
[image: ][image: ]
Accessing the Event Config tab opens up an extra set of tabs that are needed to be completed in detail. Care should be taken to ensure that all fields are completed as required and with the necessary detailed information.
[image: ]
[bookmark: _Toc463439059] Starting with the Settings Tab
The settings tab refers to global information related to this specific event being created. Detail is important to the website visitor. Ensure that every field and all data is completely filled in to present the even in a professional way.

*Start Date/Time and *End Date/Time
[image: ]These two fields refers to the period in which the event will be available. The period could be as long as one full year or longer. This is not displayed on the website as the actual timeslot or date the event is taking place. To explain; the user may have an event that takes place over several occasions throughout the year. Thus only one event will be displayed with different timeslots (occasions). If a timeslot falls outside these two dates and times, it will not be visible or displayed on the website.
It is thus important to understand the difference between a timeslot and a start date and end date.

*Event Organiser
[image: ]
A required field that needs to be completed. This person is the organiser who will also be the person that will handle enquiries and that could be contacted regarding this particular event. Kindly note that the Event Organiser must be a person with an account in the system, thus registered as a customer. This field is an autocomplete field.

Instructor Tab Name
[image: ]
On the live website the instructor tab’s name can be changed. The user might prefer the word “Facilitator” instead of instructor. Type the name that is required for this tab on the live portal. This is only required is an instructor is specified under the Links Tab.

*Instance Duration
This required field will display how long this event will be going on for. This is a text field and the user may type in any relevant information. Example: 1 Day, 8 Hours, 1 Week, etc.

*Event Type
[image: ]
The Event Type dropdown box will display what type of events is being held. The event types are defined in the Store Settings under the Event Scheduler Tab.

Enforce Event/Option quantities
[image: ]
This option enforces that select-based event options match product-level quantity availability.
[image: ]
[bookmark: _Toc463439060] The Location Tab
Today, most smartphones have Google Maps Apps installed and this feature on the platform has Google Maps integration built-in. The venue address is thus pinpoint accurately displayed.
[bookmark: _Toc463439061]Location Search
[image: ][image: ]
Simply start typing in the exact address for the venue where the event will take place. The platform uses Google to search for the address. Depending on the internet speed, this will be almost instantaneously bringing up search results that you may choose from.


[image: Image result for tip icon png][image: Image result for question icon png]Tip: The rest of the textboxes below needs to filled-in with the address details exactly the way you want them displayed with the event on the live site.

[bookmark: _Toc463439062]Street Number
[image: ]
Type in the street number for the event venue
[bookmark: _Toc463439063]Street Name
[image: ]
Type in the street name for the event venue. Important, as in some rare cases the names differ slightly from Google Maps.

[bookmark: _Toc463439064]City
[image: ]
Type in the city/town for the event venue

[bookmark: _Toc463439065]Province
[image: ]
Type in the province in which the event is taking place

[bookmark: _Toc463439066]Country
[image: ]
Type in the country for the event venue

[bookmark: _Toc463439067]Postal Code
[image: ]
Type in the postal code for the event venue. Important for certain GPS devices.

[bookmark: _Toc463439068]Latitude
[image: ]
Type in the Latitude for the event venue. The visitor will use this info to add into a GPS device
[bookmark: _Toc463439069]Longitude
[image: ]
Type in the Longitude for the event venue. The visitor will use this info to add into a GPS device
[bookmark: _Toc463439070]Additional detail
[image: ]
In some cases it will be important to describe the building or the venue to make it easy for visitors to find the venue.
[image: ]
[bookmark: _Toc463439071] The Timeslots Tab
For multi-day events, it is recommended to define the timeslots as when registration for the event should take place. Let’s elaborate on this feature a bit more. The Start Date/Time and End Date/Time that was entered under the Settings tab relates to this Timeslots tab. The user needs to ensure that the timeslots should fall within the Start Date/Time and End Date/Time period. If this is not setup correctly, the event will not be displayed on the live site.
To explain in easy terms:
The Start Date/Time and End Date/Time refers to a period. If this event is taking place only once and will never happen again, this will be the same as for the timeslots. Should this event take place multiple ties over the full year, then one would set the Start Date/Time and End Date/Time 1 January and 31 December and then specify the different timeslots as they will be available during the year. 
Further this even could be an event that is happening only on one single day, but has multiple timeslots during this day. In this case scenario the Start Date/Time and End Date/Time will be the same day but the time should be set as morning for the start and evening for the end. In the timeslots setup, you can add the different times during the day as timeslots.


[bookmark: _Toc463439072]The setup for Timeslots
[image: ]Start by clicking on the  + Sign icon which will open up the following: 
[image: ][image: ]


Click on the calendar icon next to the *Select Date field. A calendar box will open allowing the user to select the applicable date needed for the timeslot. See picture below
[image: ][image: ][image: ]

[image: ]The next step will be to add the actual start and end time and details for the time slot. Click on the + Sign as shown in the picture below to add the time and details.
[image: ][image: ]

[image: ]The following screen will open once the + Sign was clicked:
[image: ][image: ]
[image: ]The next step would be to click inside the Start Time box. This will open up the time selection tool. Simply click on the Hour or the Minute to change the value.
The same process follows for the End Time completion.

[image: ]



[image: ]
[image: ]Referring to the picture above, once the times are specified the user needs to indicate how many seats (tickets) are available for this specific timeslot. Very importantly the user also needs to specify whether to Subtract Stock. This feature is specifically important as the system will display Fully Booked when all the seats (tickets) are taken. 
To add a further extra time slot for this specific date, simply click on the icon again. The same goes for adding more dates.
[image: ]
[bookmark: _Toc463439073]The Options Tab
Option refers to the fields displayed when the visitor makes a booking. Some of these options are required and cannot be removed and others can be added or removed, made required or optional.
[image: Image result for tip icon png]Tip: The available options can be setup or created in Catalog  Options main menu on the left hand side.
[image: ]
By clicking on the remove icon, the option will not be displayed on the events entry form.

[image: ]

[image: ]
[bookmark: _Toc463439074]The Event Comms Tab
Communication with the customer when a booking was made on the live website. This is powerful feature rich functionality that will enhance the interaction with the visitor making a booking and keeping him/her updated all the time.
[image: Image result for tip icon png]Tip: Sending emails are fully customisable and can be toggled ON or OFF as required by the user.
Sending formatted emails in HTML format makes the emailed result look more professional and this it is important to understand that these emails need inline styling with the HTML code in order to have it displayed as intended in the receiver’s email software application.
Selecting the Event Comms tab will display the following screen (see picture below):

[image: Image result for tip icon png]Tip: Carefully read every field from the top to the bottom to ensure that all fields and information areas are properly filled in. Spelling is important






[image: ]
Using keys to make the email communications more personal will enhance the customer experience and the interaction will be far better received. The keys are displayed in the column on the right.


To apply keys is quite easy to understand and applied as follows:

[image: ]Example:
Dear Mary
Thank you for registering for the Health and Safety course that will take place at Central Park in Johannesburg on 18 June 2017
Kind regards
June Jones
june@somecompany.com

Using the keys, will be applied as follows:
Dear [participant_firstname]
Thank you for registering for the [event_name] that will take place at [event_location] in Johannesburg on [event_end_datetime]
Kind regards 
[organiser_firstname] [organiser_lastname]
[organiser_email]
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Events Coordinator <training@someco.com>
Booking Confirmation: Introduction to Power Tools

To Farie é Herle

Ce Eventschedue

| Message | [ introduction to Power Tools.cs (1 KB)

Dear Fanie,

We hope you are well. Just a friendly reminder that the event Introduction to Power Tools that was
booked by you or on your behalf, will take place on 2016-09-13 08:30:00.

Please find attached your Calendar Reminder.
(Tip: I using Outlook as your email program, just double click the
attachment and the reminder will be added to you Calendar)

We are locking forward to meet you
The address for the eventis:

192 Tsessebe Crescent, Corporate Park South, Old Pretoria Road
Randjespark, Midrand

Gauteng

South Africa

-25.950233 S, 28.140586 E

If you need any further information, kindly call the organiser, Peter Panman, on Tel: 011 314 7711 or
email events@someco.com
Alternatively you may call Shuwetha at SomeCo onTel: 011-314-7711 during Office Hours,

Websit:

hittp://www.opencartplugins.net/es 20160528/

Thank you kindly for your support!

Regards
The Events Coordinator
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